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INTRODUCTION
Overview

This is an installation and configuration guide for the Flow Sensor VE in a network.

For Stealthwatch System physical appliances, see the Stealthwatch SystemHardware
Installation Guide and the Stealthwatch SystemHardware Configuration Guide.

Read this chapter to learnmore about this guide and how to contact Support, if needed. This
chapter includes the following sections:

l Audience
l About the Flow Sensor VE
l Before You Begin
l How to Use ThisGuide
l Resource Requirements

Audience
The primary audience for this guide is administrators who need to install and configure
Stealthwatch Flow Sensor VE appliances. This guide assumes the audience has a basic
familiarity with VMware or KVM.

About the Flow Sensor VE
Using the same technology as the Stealthwatch Flow Sensor appliance, the Flow Sensor
VE is a virtual appliance that provides visibility into virtual environments, generating flow data
for areas that are not flow-enabled.

As a virtual appliance installed inside each virtual host, the Flow Sensor VE connects
promiscuously to the virtual switches. You can also configure the Flow Sensor VE to sense
traffic on physical network devices just as the physical Flow Sensor does. Once installed, the
Flow Sensor VE passively captures Ethernet frames from the traffic it observes and creates
flow records containing valuable session statistics that pertain to conversational pairs, bit
rates, and packet rates. The Flow Sensor VE then sends these records to any flow collector
that supports NetFlow v9.

By directing the Flow Sensor VE toward anyNetFlow v9-capable flow collector you can
derive valuable detailed traffic statistics fromNetFlow.When combined with the
Stealthwatch Flow Collector for NetFlow, the Flow Sensor also provides deep insight into

© 2018 Cisco Systems, Inc. AllRightsReserved.
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performancemetrics and behavioral indicators. These flow performance indicators provide
insight into any round-trip latency introduced by the network or by the server-side
application.

Because the Flow Sensor VE has packet-level visibility, it can calculate round-trip time
(RTT), server response time (SRT), and packet loss for TCP sessions. It includes all of these
additional fields in the NetFlow records that it sends to the Stealthwatch Flow Collector for
NetFlow.

Before You Begin
Use the information in this section to prepare for installing and configuring the Stealthwatch
VE appliances. Note that the configuration is a two-part process using first the VMware
vSphere client interface or KVM interface, and then the Appliance Administration (Admin)
interface.

Compatibility
You can use VMware vSphere Client v6.x or KVM (Kernel-based Virtual Machine) for the
virtual appliance installation. It is important to review the following compatibility information:

VMware vSphere Client v6.x or Later

l VMware ESX Version: Stealthwatch VE appliances that are running on older versions of
VMware ESX are not compatible with ESX v6.x. If you upgrade VMware to ESX v6.x, you
must delete your existing Stealthwatch VE appliances and reinstall them.

l Live migration (for example, with vMotion) from host to host is not supported.
l Virtual machine snapshots are not supported.

CAUTION! Do not install VMware Tools on a Stealthwatch virtual appliance because it will
override the custom version already installed. Doing so would render the virtual appliance
inoperable and require reinstallation.

KVM Using Any Compatible Linux Distribution

l KVM Host Versions: There are several methods used to install a virtual machine on a
KVMhost. We tested KVMand validated performance using the following components:

libvirt 3.0.0

qemu-KVM 2.8.0

Open vSwitch 2.6.1

Linux Kernel 4.4.38

Introduction
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l Virtualization Host: For minimum requirements and best performance, review the
Resource Requirements section and see the hardware specification sheet for your appli-
ance atCisco.com.

Note: The system performance is determined by the host environment. Your performance
may vary.

Installation Order
It is important to install and configure your virtual appliances in the following order:

1. UDP Director
2. Flow Collector Database 5000 Console (if used)
3. All other Flow Collectors
4. All Flow Sensors
5. Cloud License Concentrator
6. Endpoint Concentrator
7. Secondary StealthwatchManagement Console
8. Primary StealthwatchManagement Console

If you do not follow this recommended order when you set up the Stealthwatch system, the
systemmay not properly collect data from the appliances and you will have to set up each
one separately.

CAUTION! Be sure the time setting on the virtual host server (where you will be installing
the virtual appliances) reflects the correct time. Otherwise, the appliances may not be able
to boot up.

Downloading the VE Software
Before you can complete the procedures in this guide, youmust obtain the appliance
installation file (OVF or ISO) from the Download and License Center. For instructions on
downloading the file for each appliance, see the Downloading and Licensing Stealthwatch
Products document in theDownload and License Center or onCisco.com.

Registering and Licensing
As part of the configuration process, you will register and license your Stealthwatch
products. For instructions, see the Downloading and Licensing Stealthwatch Products
document in theDownload and License Center or onCisco.com.

Introduction
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Resource Requirements
This section provides the resource requirements for the virtual appliances. You can use the
tables provided in this section to record settings you will need to install and configure the
Stealthwatch VE appliances.

Flow Sensor VE

The Stealthwatch System beginning with v6.9.1 offers various types of Flow Sensor VEs
depending upon the number of NICs for the Flow Sensor VE.

The flow cache size adjusts with the amount of reservedmemory. Use the flow cache size to
calculate the amount of memory needed for the amount of traffic beingmonitored.

Note: The allocations presented in the table are only recommendations. To achieve
desired throughput, any particular environment may require more or less resources and
may depend on a number of variables, such as average packet size, burst rate, and other
network and host conditions.

NICs -
monitoring
ports (1
GB)

Reserved
CPUs

Reserved
Memory

Hardware
Throughput
Equivalent

Flow Cache Size

Flow Sensor
Base, Flow
Sensor VE

1 1 4 GB N/A 32,766

Flow Sensor
Base

4 8 16GB Up to FS1200

* Interfaces
configured as
PCI pass-
through (igb
compliant or
e1000e
compliant)

131,073

5 32 32GB Up to FS2200

* Interfaces
configured as
PCI pass-
through (igb
compliant or
e1000e
compliant)

262,145

Introduction
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Optional: One or more 10G NICs may be used on the physical VM host.

Data Storage
During installation, you will expand the available data storage on the server. Use the
following information to allocate the correct amount of storage for each appliance.

l Expansion Calculation: The virtual appliance uses approximately 75% of the server for
data storage, leaving 25% for the operating system and cache. Therefore, always expand
the data storage to 40%more than the desired amount.

l FPS Calculation: Cisco recommends allocating aminimumof 1 GB of data storage for
every 1,000 flows per second (FPS) your system averages dailymultiplied by the number
of days you want to store the flows. For example, if your system averages 2,000 FPS and
you want to store flows for 30 days, allocate aminimumof 60GB (2 X 30) of data storage
space.

l If the External Event processing (syslog) feature is used, morememory and pro-
cessing resources are required.

l Minimum Data Storage: Use the following table to determine theminimumdata storage
required for each appliance.

Stealthwatch VE Model Minimum Data Storage
StealthwatchManagement Console VE 100 GB

StealthwatchManagement Console VE 2000 200 GB

Flow Collector NetFlow VE 200 GB

Flow Collector NetFlow VE 2000 600 GB

Flow Collector NetFlow VE 4000 1.5 TB

Flow Collector sFlow VE 100 GB

Flow Collector sFlow VE 2000 600 GB

Flow Collector sFlow VE 4000 1.5 TB

Flow Sensor 50 GB

UDP Director 50 GB

Flow Sensor VE
The Flow Sensor VE requires the connection of a virtual server. For physical server
requirements, see your VMware user guide or KVMuser guide.

Introduction
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Flow Sensor VE Network Environments
Before installing the Flow Sensor VE, youmust know the type of network environment you
have. This guide covers all types of network environments that a Flow Sensor VE can
monitor.

Note: Stealthwatch supports a VDS environment, but it does not support VMware
Distributed Resource Scheduler (VM-DRS).

The Flow Sensor VE monitors the following types of virtual network environments:

l A network with virtual local area network (VLAN) trunking
l Discrete VLANswhere one or more VLANs are prohibited from attaching packet mon-
itoring devices (for example, due to local policy)

l Private VLANs
l Hypervisor hosts rather than VLANs

Information Needed for Console Access

Setting Hypervisor
Server Flow Sensor VE

Login User Name

Login Password

IP Address (Default = 192.168.1.6)

Netmask IP Address (Default = 255.255.255.0)

Gateway IP Address (Default = 192.168.1.1)

Information Needed for the Appliance Admin Interface

Setting Flow Sensor VE
IP Address (Default = 192.168.1.6)

Host Name

Network Domain Name

NTP Server IP Address(es)

DNS Server IP Address(es)

The Flow Sensor VE requires the following additional information:

Introduction
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IP addresses and listening port numbers (default = 2055) for each NetFlow collector and/or
UDP Director™ that will be receiving data from the Flow Sensor VE

_______________________________________________________________
_______________________________________________________________

How to Use This Guide
In addition to this introduction, we have divided this guide into the following chapters:

Chapter Description
Installing a Virtual Appliance How to prepare the virtual environment and install VE

appliances

Configuring the Virtual Environment How to set up the virtual environment for the
appliances

Configuring a Virtual Appliance System How to configure appliances to begin processing traffic
data

Abbreviations
The following abbreviationsmay appear in this guide:

Abbreviations Definition
DNS Domain Name System (Service or Server)

dvPort Distributed Virtual Port

ESX Enterprise Server X

GB Gigabyte

IDS Intrusion Detection System

IPS Intrusion Prevention System

ISO International Standards Organization

IT Information Technology

KVM Kernel-based Virtual Machine

MTU Maximum Transmission Unit

NTP Network Time Protocol

OVF Open Virtualization Format

SMC Stealthwatch Management Console

TB Terabyte

Introduction

© 2018 Cisco Systems, Inc. AllRightsReserved.
7



Abbreviations Definition
UUID Universally Unique Identifier

VDS vNetwork Distributed Switch

VE Virtual Edition

VLAN Virtual Local Area Network

VM Virtual Machine

Contacting Support
If you need technical support, please do one of the following:

l Contact your local Cisco Partner
l Contact Cisco Stealthwatch Support

o To open a case byweb: http://www.cisco.com/c/en/us/support/index.html
o To open a case by email: tac@cisco.com
o For phone support: 1-800-553-2447 (U.S.)
o For worldwide support numbers:www.cisco.com/en/US/partner/support/tsd_
cisco_worldwide_contacts.html

Introduction
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2

INSTALLING A VIRTUAL
APPLIANCE
Overview

This chapter describes how to install the virtual appliances.

For instructions on how to install a Stealthwatch physical appliance, see the Stealthwatch
System v6.x Hardware Installation Guide.

Compatibility: You can use one of the following for the virtual edition installation. For
compatibility details, see the Compatibility section of the Introduction.

l VMware vSphere Client v6.x or later

l KVM using any Linux distribution

Note: Confirm the time setting on the virtual host server (where you will be installing the
virtual appliances) reflects the correct time. Otherwise, the appliances may not be able to
boot up.

CAUTION! Do not install VMware Tools on a Stealthwatch virtual appliance because it will
override the custom version already installed. Doing so would render the virtual appliance
inoperable and require reinstallation.

Process Overview
Installing a virtual appliance involves completing the following procedures, which we discuss
in this chapter:

1. Configuring Your Firewall for Communications
2. Integrating the Flow Sensor VE Into Your Network
3. Installing a Virtual Appliance usingVMware vSphere Client or KVM.

© 2018 Cisco Systems, Inc. AllRightsReserved.
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Configuring Your Firewall for
Communications

In order for the appliances to communicate properly, you should configure the network so
that firewalls or access control lists do not block the required connections. Use the
information provided in this section to configure your network so that the appliances can
communicate through the network.

Consult with your network administrator to ensure that the following ports are open and have
unrestricted access:

l TCP 22
l TCP 25
l TCP 389
l TCP 443
l TCP 2393
l TCP 5222
l UDP 53
l UDP 123
l UDP 161
l UDP 162
l UDP 389
l UDP 514
l UDP 2055
l UDP 6343

Communication Ports
The following table shows how the ports are used in the Stealthwatch System:

From (Client) To (Server) Port Protocol

Admin User PC All appliances TCP/443 HTTPS

All appliances Network time
source UDP/123 NTP

Active Directory SMC TCP/389,
UDP/389 LDAP

AnyConnect Endpoint Con-
centrator UDP/2055 NetFlow

Installing a Virtual Appliance
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From (Client) To (Server) Port Protocol

Cisco ISE SMC TCP/443 HTTPS

Cisco ISE SMC TCP/5222 XMPP

Endpoint Con-
centrator Flow Collector UDP/2055 NetFlow

External log
sources SMC UDP/514 SYSLOG

Flow Collector SMC TCP/443 HTTPS

SLIC SMC
TCP/443 or
proxied
connection

HTTPS

UDP Director Flow Collector -
sFlow UDP/6343 sFlow

UDP Director Flow Collector -
NetFlow UDP/2055* NetFlow

UDP Director
3rd Party event
management
systems

UDP/514 SYSLOG

Flow Sensor SMC TCP/443 HTTPS

Flow Sensor Flow Collector -
NetFlow UDP/2055 NetFlow

Identity SMC TCP/2393 SSL

NetFlow
Exporters

Flow Collector -
NetFlow UDP/2055* NetFlow

sFlow Exporters Flow Collector -
sFlow UDP/6343* sFlow

SMC Cisco ISE TCP/443 HTTPS

SMC DNS UDP/53 DNS

SMC Flow Collector TCP/443 HTTPS

Installing a Virtual Appliance
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From (Client) To (Server) Port Protocol

SMC Flow Sensor TCP/443 HTTPS

SMC Identity TCP/2393 SSL

SMC Flow Exporters UDP/161 SNMP

SMC Endpoint Con-
centrator UDP.2055 HTTPS

User PC SMC TCP/443 HTTPS

*This is the default NetFlow port, but any UDP port could be configured on the exporter.

The following table is for optional configurations determined by your network needs:

From (Client) To (Server) Port Protocol

All appliances User PC TCP/22 SSH

SMC 3rd Party event
management systems UDP/162 SNMP-trap

SMC 3rd Party event
management systems UDP/514 SYSLOG

SMC Email gateway TCP/25 SMTP

SMC SLIC TCP/443 SSL

User PC All appliances TCP/22 SSH

The following diagram shows the various connections used by the Stealthwatch System.
The portsmarked as optionalmay be used according to your own network needs.

Installing a Virtual Appliance
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Integrating the Flow Sensor VE Into Your
Network
The Flow Sensor VE has the ability to provide visibility into your network as a passivemonitoring
device. It can sit at multiple points on your network to observe and record IP activity, thereby
protecting network integrity and detecting security breaches. The Flow Sensor features integrated
Web-basedmanagement systems that facilitate either centralized or remotemanagement and
administration.

Placing the Stealthwatch Flow Sensor
The Flow Sensor VE appliance ismost effective when placed at critical segments of your
corporate network as follows:

Installing a Virtual Appliance
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l Inside your firewall to monitor traffic and determine if a firewall breach has occurred
l Outside your firewall, monitoring traffic flow to analyze who is threatening your firewall
l At sensitive segments of your network, offering protection from disgruntled employees
or hackers with root access

l At remote office locations that constitute vulnerable network extensions
l On your business network for protocol use management (for example, on your trans-
action services subnet to determine if a hacker is running Telnet or FTP and com-
promising your customers' financial data)

Important Considerations for Integration
The Stealthwatch Flow Sensor VE is versatile enough to integrate with a wide variety of
network topologies, technologies, and components. Before you install a Flow Sensor VE,
youmust make several decisions about your network and how you want to monitor it. It is
important to review the following:

l Analyze your network's topology and your specificmonitoring needs.
l Connect a Flow Sensor so that it receives network transmissions to and from themon-
itored network, and, if desired, receives interior network transmissions aswell.

l For optimum performance when using the Flow Sensor to monitor physical network
traffic, configure your Flow Sensor VE with direct access to the underlying physical host’s
NICs (such as using an igb or e1000e compliant PCI pass-through).

The following sections explain how to integrate a Stealthwatch Flow Sensor VE appliance
into your network using the following Ethernet network devices:

l TAPs
l SPAN Ports

Note: While not all network configurations can be discussed here, the examples may help
you determine the best setup for your monitoring needs. These examples provide physical
network scenarios, and the virtual host can be configured in a similar way.

TAPs
When a Test Access Port (TAP) is placed in line with a network connection, it repeats the
connection on a separate port or ports. For example, an Ethernet TAP placed in line with an
Ethernet cable will repeat each direction of transmission on separate ports. Therefore, use of
a TAP is themost reliable way to use the Flow Sensor. The type of TAP you use depends on
your network.

For important configuration information, seeConfigure the Advanced Settings in the
Configuring a Virtual Appliance chapter.

This section explains the following ways to use TAPs:

Installing a Virtual Appliance
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l Using Electrical TAPs
l UsingOptical TAPs
l Using TAPsOutside Your Firewall
l Placing the Flow Sensor VE Inside Your Firewall

Note: In a network using TAPs, the Flow Sensor VE can capture performancemonitoring
data only if it is connected to an aggregating TAP that is capturing both inbound and
outbound traffic. If the Flow Sensor VE is connected to a unidirectional TAP that is
capturing only one direction of traffic on each port, then the Flow Sensor VE will not capture
performancemonitoring data.

Using Electrical TAPs
The following illustration shows the Stealthwatch Flow Sensor VE connected to an Ethernet
electrical TAP. To achieve this configuration, connect the two TAP ports to the Flow Sensor
VE Monitor Ports 1 and 2, as shown.

Using Optical TAPs
Two splitters are required for fiber-optic–based systems. You can place a fiber-optic cable
splitter in line with each direction of transmission and use it to repeat the optical signal for one
direction of transmission.

The following illustration shows the Flow Sensor connected to a fiber-optic–based network.
To achieve this configuration, connect the outputs of the optical splitters to the Flow Sensor
VE Monitor Ports 1 and 2, as shown.

Installing a Virtual Appliance
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Note: If the connection between themonitored networks is an optical connection, then the
Stealthwatch Flow Sensor VE appliance is connected to two optical splitters. The
management port is connected to either the switch of themonitored network or to another
switch or hub.

Using TAPs Outside Your Firewall
To have the Flow Sensor VE monitor traffic between your firewall and other networks,
connect the Stealthwatchmanagement port to a switch or port outside of the firewall.

WARNING! Cisco strongly recommends that you use a TAP for this connection so that
failure of the device does not bring down your entire network.

The following illustration shows an example of this configuration using an Ethernet electrical
TAP. Themanagement port must be connected to the switch or hub of themonitored
network. This setup is similar to the setup that monitors traffic to and from your network.

Note: If your firewall is performing network address translation (NAT), you can observe
only the addresses that are on the firewall.

Installing a Virtual Appliance
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Placing the Flow Sensor VE Inside Your Firewall
Tomonitor traffic between internal networks and a firewall, the Flow Sensor VE must be able
to access all traffic between the firewall and the internal networks. You can accomplish this
by configuring amirror port that mirrors the connection to the firewall on themain switch.
Make sure that the Flow Sensor VE Monitor Port 1 is connected to themirror port, as shown
in the following illustration:

Tomonitor traffic inside your firewall by using a TAP, insert the TAP or optical splitter
between your firewall and themain switch or hub. A TAP configuration is shown below.

An optical splitter configuration is shown below.

Installing a Virtual Appliance
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SPAN Ports
You can also connect the Flow Sensor VE to a switch. However, because a switch does not
repeat all traffic on each port, the Flow Sensor VE will not perform properly unless the switch
can repeat packets transmitted to and from one or more switch ports. This type of switch port
is sometimes called amirror port or Switch Port Analyzer (SPAN).

The following illustration shows how you can achieve this configuration by connecting your
network to the Stealthwatch Flow Sensor VE through themanagement port.

In this configuration, youmust configure a switch port (also called amirror port), to repeat all
traffic to and from the host of interest to themirror port. The Flow Sensor VE Monitor Port 1
must be connected to thismirror port. This allows the Flow Sensor to monitor traffic to and
from the network of interest and to other networks. In this instance, a networkmay bemade
up of some or all of the hosts connected to the switch.

A commonway of configuring networks on a switch is to zone them into virtual local area
networks (VLANs), which are logical rather that physical connections of hosts. If themirror
port is configured tomirror all ports on a VLAN or switch, the Flow Sensor VE canmonitor all
traffic to, from, and within the network of interest, as well as other networks.

Installing a Virtual Appliance
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For important configuration information, seeConfigure the Advanced Settings in the
"Configuring a Virtual Appliance" chapter.

Note: In all cases, Cisco recommends that you consult your switchmanufacturer's
documentation to determine how to configure the switchmirror port and what traffic will be
repeated to themirror port.

Note: Go to the section that is applicable to your virtual appliance installation: VMware
vSphere Client or KVM.

Installing a Virtual Appliance
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INSTALLING A VIRTUAL
APPLIANCE USING VMWARE
VSPHERE CLIENT
Overview

This chapter describes how to install the virtual appliances using VMware vSphere Client
v6.

Before You Begin
Before you begin the installation, complete the following preparation procedures:

1. Download theOVF file from the Download and License Center. See the Downloading
and Licensing Guide for instructions.

2. Review the Compatibility information in the Introduction.
3. Configure Your Firewall for Communications.
4. Review the Resource Requirements section to determine the proper allocations for the

appliance. You can use a resource pool or alternativemethod to allocate resources.
5. Confirm the time set on the ESX server (where you will be installing the virtual appliance)

reflects the correct time. Otherwise, the virtual appliancesmay not be able to boot up.

WARNING! Do not install an untrusted physical or virtual machine on the same physical
cluster/system as your Stealthwatch System appliances.

CAUTION! Do not install VMware Tools on a Stealthwatch virtual appliance because it will
override the custom version already installed. Doing so would render the virtual appliance
inoperable and require reinstallation.

Process Overview
Installing a virtual appliance involves completing the following procedures, which are
covered in this chapter:

1. Logging in to the VMware vSphere Client
2. Configuring the Virtual Appliance toMonitor Traffic
3. Installing the Virtual Appliance
4. Defining AdditionalMonitoring Ports

Installing a Virtual Appliance using VMware vSphere Client
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Logging in to the VMware vSphere Client
To install the virtual appliance, youmust first log in to the VMware vSphere Client v6.x, by
completing the following steps:

Note: Whether you are using the The VMware vSphere Client orWebClient interface,
some of the graphics and commands may vary from the information shown here. Please
see your VMware vSphere guide for details related to the software.

1. Launch the VMware vSphere Client software. The Login dialog opens.

2. Type the IP address of the ESX server and your login credentials.
3. Click Login. The Home page opens.

Configuring the Virtual Appliance to Monitor
Traffic
The Flow Sensor VE has the ability to provide visibility into VMware environments, generating flow
data for areas that are not flow-enabled. As a virtual appliance installed inside each vSphere/ESX
host, the Flow Sensor VE passively captures Ethernet frames from traffic it observes and creates
flow records containing valuable session statistics that pertain to conversational pairs, bit rates,
and packet rates. For details, see Installing a Virtual Appliance: Integrating the Flow Sensor VE
into your network.

Use the following instructions to configure the Flow Sensor VE tomonitor traffic on a vSwitch as
follows:

l Monitoring a vSwitch with Multiple Hosts
l Monitoring a vSwitch with a Single Host

Monitoring a vSwitch with Multiple Hosts
Use the instructions in this section to use the Flow Sensor VE tomonitor traffic on a Distributed
vSwitch that spansmultiple VM hosts or clusters.

Installing a Virtual Appliance using VMware vSphere Client
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Note: This section applies only to VDS networks. If your network is in a non-VDS
environment, go toMonitoring a vSwitch with a Single Host

This configuration has the following requirements: 

l Distributed Virtual Port (dvPort): Add a dvPort group with the correct VLAN settings for
each VDS that the Flow Sensor VE will monitor. If the Flow Sensor VE monitors both
VLAN and non-VLAN traffic on the network, you need to create two dvPort groups, one
for each type.

l VLAN Identifier: If your environment uses a VLAN (other than VLAN trunking or a private
VLAN), you will need the VLAN identifier to complete this procedure.

l Promiscuous Mode:  enabled
l Promiscuous Port: configured to the vSwitch

Complete the following steps to configure the network using a VDS:

1. In the View menu, select Inventory > Networking to display the Networking tree on the
left.

On theWeb client, click Networking in the Inventory Tree list:

2. In the Networking tree, select the VDS.
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3. In the right pane, click Create a new port group.

The Create dvPort Group wizard opens.

Note: TheWebClient has two dialogs for the configuration: Select name and location and
Configure settings.
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4. In the Name field, type the name you want to use to identify this dvPort group.
5. In the Number of Ports field, type the number of Flow Sensor VEs in your cluster of

hosts.
6. Does your environment use a VLAN?

l If yes, select the VLAN type from the drop-down list. Then, go to Step 7.
l If no, select None from the VLAN type drop-down list. Then, go to step 8.

7. Based on the VLAN type you selected, perform the action indicated in the following table:

VLAN Type Detail

VLAN
In the VLAN ID field, enter the number (between 1 and
4094) that matches the identifier.

VLAN Trunking
In the VLAN trunk range field, enter 0-4094 to monitor
allVLAN traffic.

Private VLAN Select Promiscuous from the drop-down list.

8. Click Next. A Summary page opens.

9. After reviewing the settings, click Finish. The new dvPort group appears in the Net-
working tree.
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10. Right-click the new dvPort group. Select Edit Settings.

The Settings dialog opens.

11. In the left pane, select Security.
12. In the right pane in the PromiscuousMode drop-down list, select Accept.
13. ClickOK to close the dialog.
14. Does the Flow Sensor VE monitor both VLAN and non-VLAN network traffic?

l If yes, repeat the steps in this sectionMonitoring a vSwitch with Multiple Hosts
l If no, continue to the next step.

15. Is there another VDS on the ESX server that the Flow Sensor VE will monitor?
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l If yes, repeat the steps in this sectionMonitoring a vSwitch with Multiple Hosts for the
next VDS.

l If no, go to Installing the Virtual Appliance.

Monitoring a vSwitch with a Single Host
Use the instructions in this section to use the Flow Sensor VE tomonitor traffic on a vSwitch with a
single host.

Note: This section applies only to non-VDS networks. If your network uses a VDS, go to
Monitoring a vSwitch with Multiple Hosts.

This configuration has the following requirements: 

l Promiscuous Port Group: Add a promiscuous port group for each virtual switch that the
Flow Sensor VE will bemonitoring.

l Promiscuous Mode:  enabled
l Promiscuous Port: configured to the vSwitch

Complete the following steps to configure the network using a non-VDS environment.

1. Add a Port Group
2. Set the Port Group to PromiscuousMode

Add a Port Group
To add a port group, complete the following steps:

1. In the Inventory tree, select the ESX server, and then click the Configuration tab.
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TheConfiguration page opens.

2. In the Hardware pane, click Networking.

The Configuration tab displays the list of installed virtual switches.
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3. Scroll through the list to locate the virtual switch that the Flow Sensor VE will bemon-
itoring, and then click the Properties link. The Properties dialog for that virtual switch
opens.

4. Click Add. The AddNetworkWizard opens to the Connection Type page.
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5. Under Connection Types, select Virtual Machine. Click Next. The Connection Settings
page opens.

6. Optional:  Change the Network Label for the port group.
7. Click the VLAN ID drop-down list and select All (4095) to allow the Flow Sensor VE to

see traffic on all VLANs through this port group.
8. Click Next. The Summary page opens, showing the port group you added.
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9. Click Finish to return to the virtual switch Properties dialog, which shows the new port
group.

10. Continue with the next section.
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Set the Port Group to Promiscuous Mode
To set the port group to PromiscuousMode, complete the following steps:

1. On the virtual switch Properties dialog, select the port group you just added and click Edit.

The Properties dialog for the port group opens.

2. Click the Security tab to display the Policy Exceptions options.
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3. Click the Promiscuous Mode checkbox. Select Accept from the drop-down list.
4. ClickOK to return to the virtual switch Properties dialog.
5. Click Close to dismiss the virtual switch Properties dialog. The new port group appears

on the Networking page of the Configuration tab.
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6. Will the Flow Sensor VE bemonitoring another virtual switch on this ESX server?

l If yes, go back to Configuring the Virtual Appliance toMonitor Traffic, and repeat all
the steps for the next virtual switch.

l If no, continue with the next section, Installing the Virtual Appliance.

Installing the Virtual Appliance
To install a virtual appliance on the ESX server and define the virtual appliancemanagement
andmonitoring ports, complete the following steps:

1. Locate the virtual appliance software file (OVF.TGZ) that you downloaded from the Down-
load and License Center.

2. Unzip or open the file, and then untar it.
l To untar the file, select all the files in the folder and extract them.
l Unzipping TGZ file is a two-step process, and the stepsmay vary depending on the
software you use.

3. On the vSphere client menu, click File > Deploy OVF Template.
Web Client: Right-click the host. Select Deploy OVF Template.

Note: TheWeb client OVF template wizardmay vary from the images and instructions
shown here, but the steps are similar. One example is theWeb client uses Source Location
instead of Source. The image below shows the steps on the left side for a OVF template
ready to deploy:
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TheDeployOVF Template wizard opens.

4. Click Browse. Navigate to select the virtual applianceOVF file.
5. Click Next to display the OVF Template Details page.

Web Client: The 1.b. Review details page opens.
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6. Click Next. Review the End User License Agreement.
Web Client: 1c. Accept EULAs.

7. After reviewing the information, click Accept. Click Next. The Name and Location page
opens.
Web Client: 2a. The Name and Location page opens.
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8. Optional: Change the name and location for the virtual appliance. This should be a
unique name and will display in the Inventory tree. Click Next.

9. On the Storage page, select where you want to store the data files. Click Next.
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10. On the Disk Format page, select Thick Provision Lazy Zeroed or Thick Provision
Eager Zeroed. Click Next.

l Use the Thin Provision format only if your disk space is limited.
l For more information, see your VMware documentation.
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11. On the NetworkMapping page, select the networks for the virtual appliance. Click Next.
Web Client: The 2c. Setup Networks page opens.
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12. On the Ready to Complete page, review the summary of settings. If they are correct, click
Finish.
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13. The deployment dialog box opens.

14. When the deployment is completed, click Close The installed virtual appliance appears
in the Inventory tree.

15. Are you installing a Flow Sensor VE, which will bemonitoringmore than one virtual
switch on an ESX server or more than one VDS in a cluster?

l If yes, continue with the next section, Defining AdditionalMonitoring Ports.
l If no, go to Configuring the Virtual Environment
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Defining Additional Monitoring Ports
Note: This procedure is necessary only if the Flow Sensor VE will bemonitoringmore than
one virtual switch on an ESX server or more than one VDS in a cluster.

To add Flow Sensor VE monitoring ports, complete the following steps:

1. In the Inventory tree, right-click the Flow Sensor VE, and then select Edit Settings.

The Flow Sensor VE Virtual Machine Properties dialog opens.
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2. Click Add. The AddHardware dialog opens to the Device Type page.

3. Select Ethernet Adapter in the list of device types, and then click Next. The Network Type
page opens.
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4. Do the following:

l In the Adapter Type section, select VMXNET 3.
l In the Network Connection section, select an unassigned promiscuous port group.
l In the Device Status section, make sure that the Connect at power on check box is
selected.

5. Click Next to see a summary.
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6. After reviewing the settings, click Finish.
7. The Flow Sensor VE Virtual Machine Properties dialog opens, showing the newly

definedmonitor port.

8. Will the Flow Sensor VE bemonitoring another virtual switch on the ESX server or
another VDS in a cluster?

l If yes, repeat this procedure for the next virtual switch.
l If no, clickOK to return to the vSphere Client Home page.

9. Go to Configuring the Virtual Environment
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INSTALLING A VIRTUAL
APPLIANCE ON A KVM HOST
Overview

This chapter describes how to install the virtual appliances using KVM and Virtual Machine
Manager.

Before You Begin
Before you begin the installation, complete the following preparation procedures:

1. Download the ISO file from the Download and License Center and copy the image to a
folder on the KVM host. In the example given below, the folder is var/lib/libvirt/image. See
the Downloading and Licensing Guide for instructions.

2. Review the Compatibility information in the Introduction.
3. Configure Your Firewall for Communications.
4. Review the Resource Requirements section to determine the proper allocations for the

appliance.
5. Confirm the time set on the virtual host server (where you will be installing the virtual appli-

ance) reflects the correct time. Otherwise, the virtual appliancesmay not be able to boot
up.

WARNING! Do not install an untrusted physical or virtual machine on the same physical
cluster/system as your Stealthwatch System appliances.

Process Overview
Installing a virtual appliance involves completing the following procedures, which are covered
in this chapter:

l Installing a Virtual Appliance on a KVMHost
l Adding NIC and Promiscuous Port Monitoring on anOpen vSwitch
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Installing a Virtual Appliance on a KVM Host
There are several methods to install a virtual machine on a KVMhost using a ISO file. The
following steps give one example for installing a virtual SMC appliance through aGUI tool
called Virtual MachineManager running on a Ubuntu box. You can use any compatible Linux
distribution. For compatibility details, see the Compatibility section of the Introduction.

Monitoring Traffic: The Flow Sensor VE has the ability to provide visibility into KVM
environments, generating flow data for areas that are not flow-enabled. As a virtual
appliance installed inside each KVMhost, the Flow Sensor VE passively captures Ethernet
frames from traffic it observes and creates flow records containing valuable session statistics
that pertain to conversational pairs, bit rates, and packet rates. For details, see Installing a
Virtual Appliance: Integrating the Flow Sensor VE into your network.

This configuration has the following requirements, which is covered in this chapter:

l Promiscuous Mode:  enabled
l Promiscuous Port: configured to an open vSwitch

To install a virtual appliance, and enable the Flow Sensor VE tomonitor traffic, complete the
following steps:

1. Use Virtual MachineManager to connect to the KVMHost.

2. Click File > New Virtual Machine.

3. Select Local install media (ISO image or CDROM), and then click Forward.
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4. Click Use ISO image.
5. Click Browse. Select the appliance image.

6. Select the ISO file. Click Choose Volume.

Note: Confirm the ISO file is accessible by the KVMHost.
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7. Under Choose an operating system type and version, select Linux from theOS type
drop-down list.

8. From the Version drop-down list, select Debian Jessie. Click Forward.

9. Increase theMemory (RAM) and CPUs to the amount shown in the Resource Require-
ments section.
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10. Click Forward.
11. Select Create a disk image for the virtual machine.
12. Enter the data storage amount shown for the appliance in the Resource Requirements

section. Click Forward.

13. Assign a Name for the virtual machine. This will be the display name, so use a name that
will help you find it later.

14. Select the Customize configuration before install check box.
15. In the Network selection drop-down box, select the applicable network and port group for

installation.
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16. Click Finish. The configurationmenu opens.

Installing a Virtual Appliance on a KVM Host

© 2018 Cisco Systems, Inc. AllRightsReserved.
50



17. In the navigation pane, select NIC.
18. Under Virtual Network Interface, select e1000 in the Devicemodel drop-down box. Click

Apply.

19. Click VirtIO Disk 1.
20. In the AdvancedOptions drop-down list, select SCSI in the Disk bus drop-down box.

Click Apply.
21. Do you need to add additional NICS for monitoring ports on the Flow Sensor VE? 

l If yes, go to Adding NIC and Promiscuous Port Monitoring on anOpen vSwitch.
l If no, go to the next step.

21. Click Begin Installation.
22. Go to Configuring the Virtual Environment.
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Adding NIC and Promiscuous Port
Monitoring on an Open vSwitch
To add additional NICs for the Flow Sensor VE monitoring ports and to complete the installation,
complete the following steps: 

1. In the ConfigurationMenu, click Add Hardware. The Add New Virtual HardwareWizard
displays.

2. In the left navigation pane, click Network.
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3. Click the Portgroup drop-down list to select an unassigned promiscuous port group you
want to monitor. Click the DeviceModel drop-down list to select e1000.

4. Click Finish.
5. If you need to add another monitoring port, repeat these instructions.
6. After you have added all monitoring ports, click Begin Installation.
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3

CONFIGURING THE VIRTUAL
ENVIRONMENT
Overview

After you install the Stealthwatch VE appliances, you are ready to configure the virtual
environment for them. This process involves completing the following procedures as detailed
in this chapter:

1. Configure the IP Addresses
2. Change the Default User Passwords

Configure the IP Addresses
To configure the IP addresses for a virtual appliance, complete the following steps:

1. Connect to your Hypervisor host (virtual machine host).
2. In the Hypervisor host, locate your virtual machine.
3. Confirm the virtual machine is powered on.

Note: If the virtual machine does not power on and you receive an error message about
insufficient available memory, do one of the following:

l Increase the available resources on the system where the appliance is installed. See the
Resource Requirements section for details.

l ESX server: Increase the memory reservation limit for the appliance and its resource
pool.

4. Access the virtual machine console.
5. Allow the virtual appliance to finish booting up. The virtual appliance Administrative IP

Address page opens.

Note: Youmay need to enable the Full ScreenMode to view the entire screen.
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6. Click on the page. Enter the IP address for the virtual appliance.
7. Select OK, and then press Enter. The IP Netmask page openswith the default network

mask IP address.

8. Do the following:

l Accept the default value or enter a new one based on your environment.
l Select OK and press Enter to continue.

The IP Broadcast Address page openswith the default broadcast IP address.

9. Do the following:

l Accept the default value or enter a new one based on your environment.
l Select OK and press Enter to continue.

TheGatewayAddress page openswith the default gateway server IP address.
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10. Do the following:

l Accept the default value or enter a new one based on your environment.
l Select OK and press Enter to continue.

A page opens showing a summary of your entries.

11. Review the information. Are the settings are correct?

l If yes, go to the next step.
l If no, go to step 13.

12. Press Enter. The system restart page opens.
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13. Press Enter. The system restarts and implements the changes. On completion, a login
prompt appears.

14. Select No and press Enter. The Administrative IP Address page opens. Repeat steps 5
through 10 tomake any necessary changes. The system restart page opens.

15. Press Enter. The system restarts and implements the changes. On completion, a login
prompt appears.

16. PressCtrl + Alt to exit the console.
17. Go to Change the Default User Passwords next in this chapter.

Change the Default User Passwords
Important: To ensure that your network is secure, youmust change the default password
for the sysadmin and root users.

Changing the sysadmin Password
To change the sysadmin password, complete the following steps:
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1. At the login page, do the following:

a. Type sysadmin (case-sensitive), and then press Enter.

b. When the password prompt appears, type lan1cope, and then press Enter.

2. On the SystemConfigurationmenu, select Password and press Enter.

Important: If you change the trusted hosts list from the defaults, youmust make sure
each Stealthwatch appliance is included in the trusted host list for every other
Stealthwatch appliance in your deployment. Otherwise, the appliances will not be able to
communicate with each other.

A prompt for the current password appears below themenu.

3. Type the current password, and then press Enter.

The prompt for a new password appears.

Configuring the Virtual Environment

© 2018 Cisco Systems, Inc. AllRightsReserved.
59



4. Type the new password, and then press Enter.

Notes:

l The passwordmust be between 8 and 30 alphanumeric characters in length with no
spaces. You alsomay use the following special characters: $.~!@#%_=?:,{}()

l Any password changemust be different from the previous password by at least
four characters.

5. Type the new password again, and then press Enter. A message appears indicating that
the password was updated successfully.

6. Press Enter to return to the SystemConfiguration Consolemenu.
7. Continue with the next section, “Changing the root Password.”
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Changing the root Password
To change the root password, complete the following steps:

1. On the SystemConfiguration Consolemenu, select Advanced, and then press Enter.
The Advancedmenu opens.

2. On the Advanced menu, select RootShell, and then press Enter.

A prompt for the root password appears.

3. Type the current root password, lan1cope, and then press Enter. The root shell prompt
appears.
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4. Type SystemConfig (case-sensitive), and then press Enter.

This returns you to the SystemConfigurationmenu so that you can change the root
password.

5. Select Password, and then press Enter. The password prompt appears.

6. Type the new root password, and then press Enter. A second prompt appears below the
menu.

7. Retype the new root password, and then press Enter.
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Amessage appears indicating that the password was updated successfully.

8. When your password change is successful, type exit, and then press Enter. You have
now changed both of your default sysadmin and root passwords.

9. PressCtrl+Alt to exit the console environment.
10. Have you completed all of the procedures in this chapter for all of the virtual appliances?

l If yes, continue with Configuring a Virtual Appliance System.
l If no, return to Configure the IP Addresses and repeat all of the procedures in this
chapter for the next virtual appliance. Then, go to the Configuring a Virtual Appliance.
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4

CONFIGURING A VIRTUAL
APPLIANCE
Overview

This chapter provides the procedures for configuring the virtual appliance to begin
processing traffic data. Once you have completed the steps in this chapter, the installation
and configuration process is complete.

Note: Please refer to the checklist on “Before You Begin” on page 2 for the information you
will need before proceeding.

Process Overview
Configuring a virtual Stealthwatch appliance involves completing the following procedures,
which we discuss in this chapter:

1. Configuring the Individual Appliances
2. Expand Data Storage and Resource Allocations
3. Configuration through the Appliance Admin Interface

Configuring the Individual Appliances
Initial configuration of every appliance is done with the Appliance Setup Tool. The first time
you access the appliance, the Appliance Setup Tool is displayed.

It is important to install and configure your virtual appliances in the following order:

1. UDP Director VE
2. Flow Collector Database 5000 Console (if used)
3. All other Flow Collectors
4. All Flow Sensors
5. Cloud License Concentrator
6. Endpoint Concentrator
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7. Secondary StealthwatchManagement Console
8. Primary StealthwatchManagement Console

Before you begin, gather the information detailed in the “Before You Begin” on page 2.

Note: Your screens may look slightly different from the ones presented here depending on
your environment.

To configure an appliance, complete the following steps:

1. In the address field of your browser, type https:// followed by the IP address of the virtual
appliance, and then press Enter.

2. The admin login page opens. Type admin and lan411cope (both are case sensitive), and
then click Login. Go to step 5.

3. TheWelcome page opens. Click Continue

TheManagement Network Interface page opens.
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6. Review the settings you previously entered, and then click Next. The PasswordMan-
agement page opens.

7. In the appropriate fields, type your new admin password, and then click Next. The Host
Name and Domain page opens.
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8. In the appropriate fields, type the host name and the network domain name, and then
click Next. The DNS Settings page opens.

9. Click the + button, and then type the IP address of the DNS server. Click Next. The NTP
Settings page opens.

Note: Please set the first NTP server to be pool.ntp.org. This will allow the Stealthwatch
appliance to access the random ntp.org pool of NTP servers to set the appliance’s time.
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10. You can accept the default setting or enter another server
by entering the IP address of your NTP server or select-
ing a name by clicking the list icon and selecting one from
the drop-down list. See Configuration through the Appli-
ance Admin Interface

11. Click Next. The Review page opens.
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12. Review your settings, and then click Apply. The confirmation dialogue opens.

13. Allow a few minutes for your new system settings to take effect and then click Next. When
finished, the login page for the appliance opens.

14. Enter the login credentials, and then click Login.

15. Do you have any other appliances to configure?

l If yes, return to Step 1 and repeat this procedure for the next appliance. Remember to
configure the primary SMC last.

l If no, go to the next step.

Expand Data Storage and Resource
Allocations

To install a virtual appliance, youmay need to expand the available data storage. Also, you
maywant to expand the appliance resource allocations to improve performance.

l For data storage ranges and resource allocation information, see theResource
Requirements: Data Storage section.

l If you increase the virtual machinememory using another method on your Hypervisor
host, restart the appliance after you have saved your changes.

To expand the virtual appliance data storage, complete the following steps:

1. Connect to your Hypervisor host (virtual machine host).
2. In the Hypervisor host, locate your virtual machine.
3. Power off the virtual machine.
4. Access the virtual machine console.
5. Click on the page, and then do the following: 

a. Type sysadmin, and then press Enter.

b. When the password prompt appears, type lan1cope, and then press Enter.

The SystemConfigurationmenu opens.
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6. Select the Advanced option, and then press Enter. The Advancedmenu page opens.

7. Select the DataStorageExpansion option. The Data Storage Expansion page opens.
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8. Review the information and change it as needed. To save your changes, select Yes, and
press Enter. TheWarning page opens.

9. Select Yes, and then press Enter. The virtual appliance restarts and implements the
changes.

10. PressCtrl+Alt to exit the console environment.
11. Confirm the changesmade to the data storage.

Configuration through the Appliance Admin
Interface

This section provides the following procedures to complete the configuration of a virtual
appliance using its Appliance Admin interface:

1. Log in to the Appliance Administration Interface
2. Configuring a Virtual Appliance
3. Restart the Virtual Appliance

Log in to the Appliance Administration Interface
To log in to the Appliance Administration (Admin) interface, complete the following steps:

Notes:

l The supported browsers for Stealthwatch are Internet Explorer version 11 and later,
and the latest versions of Firefox, Google Chrome, and Safari.

l If you have trouble loading any of the pages, try a different browser, or clear your
browser cache, close and re-open your browser, and then log in again.
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1. In the address field of your browser, type https:// followed by the IP address of the virtual
appliance, and then press Enter.

Note: Depending on the speed of your VM host, it may take approximately 30minutes for all
services to boot up.

2. The Flow Sensor VE Appliance Admin interface landing page opens.

3. In the User Name field, type admin.
4. In the Password field, type the admin password you created in the appliance setup.
5. Click Login. The Appliance Admin interface Home page opens.

6. Continue with the next section, “Configure the Advanced Settings.”

Configure the Advanced Settings
If you want the Flow Sensor VE to identify applications, configure the following settings for
your Flow Sensor VE:

1. In theWebClient Admin Appliance, select Configuration > Advanced Settings.
2. Select the Export Application Identification check box. By default, this option is not selec-

ted.

3. In the CacheMode section, select one of the following options based on your method for
monitoring flows:

l TheUse single, shared, cache for all monitoring ports option is typically used for sys-
tems that monitor flows using the TAPmethod.
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l TheUse independent caches for each monitoring port option is typically used to
experience better performance and for systems that monitor flows using the
SPAN method.

Restart the Virtual Appliance
To restart the virtual appliance, complete the following steps:

1. On the Appliance Admin interfacemenu, select Operations > Restart Appliance.

The confirmation dialog opens.

2. Click Yes.
3. After you restart the appliance, continue installing and configuring your appliances in the

order shown in Configuring the Individual Appliances. After you activate the product
licenses on the appliance, the Flow Sensor VE will begin collecting data from the VM
environment and sending it to the NetFlow collector. See the Downloading and Licensing
Guide for details.

Congratulations, you have now completely installed and configured the Flow Sensor VE!
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l SMC Client Enterprise Tree: The Flow Sensor will be listed on the SMC Client Enter-
prise tree under the Flow Sensors and VM Servers branches.

l Traffic Detection: The Flow Sensor will appear on the SMC Enterprise tree when the
Flow Sensor has an active license, detects traffic, and sends data to the Flow Collector,
which sends data to the SMC.

l Please see the SMC Client Online Help and the Downloading and Licensing Guide for
more information.
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